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Question Number : 1 Question Id : 2549896363 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

A is a utility program that rearranges files and unused disk space to optimise operations.
Options :

1. # compression tool

2. # disk cleanup tool

3. * backup utility

4. % disk defragmenter

Question Number : 1 Question Id : 2549896363 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

_ Uo geifad v g, ST dfsharell & sdmad & e wTRdl SR SvRad f&% e SiaRTall ! gedaryd HRal g
Options :

1. % HWYETA

2. % fS¥p FKASU ¢

3. % Jwa gRRA

4. ¢ &% SR

Question Number : 2 Question Id : 2549896712 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
3 Mega Pixels (3MP) means

Options :

1. ¥ 2048%1536 Pixels

2. % 1240%x480 Pixels

3. ¥ 340%280 Pixels

4. ¥ 540%450 Pixels

Question Number : 2 Question Id : 2549896712 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
3T fodd gmp) BT 3 g |
Options :

1. ¥ 2048x1536 fURTa

2. % 1240x480 U

3. % 340x280 fURTa

4. % 540x450 TOFQ

Question Number : 3 Question Id : 2549897064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

To make the number pad act as directional arrows, you press the key.
Options :

1. ¥ Num Lock

2. % Caps Lock

3. % Arrow Lock

4. % Shift

Question Number : 3 Question Id : 2549897064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

FoR U &1 fammdd® IR & &9 8 &1 A & forg, s ol gad g |
Options :

1. ¥ Num Lock

2. % Caps Lock

3. % Arrow Lock

4. % Shift

Question Number : 4 Question Id : 2549897069 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time :

Correct Marks : 1 Wrong Marks : 0
What type of software is LINUX?



Options :

1. #* Disk Cleanup Tool
2. % Operating System
3. % Utility software

4. % Application software

Question Number : 4 Question Id : 2549897069 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

LINUX {59 UHR &1 IR g2
Options :

1. % {$% oM gd
2. ¢ 3R ReH
3. * gfeferd witedmr

4. % Tb M I daR

Question Number : 5 Question Id : 2549897503 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following tab is NOT available in OpenOffice 4.0 main menu?
Options :

1. ¥ Convert

2. % Tools

3. # View

4. ¥ File

Question Number : 5 Question Id : 2549897503 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
9 T § HH A1 ¢ Sl Siifthd 4.0 U9 A= H U 781 82

Options :



1. ¥ Hac
2. % T
3. % 3
4. % Th[gd

Question Number : 6 Question Id : 2549897556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The word size of the most modern general purpose computers usually is
Options :

1. ¥ 64 bits

2. % 74 bits

3. #* 38 bits

4. % 16 bits

Question Number : 6 Question Id : 2549897556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

qTH T TG ST o ToTT TRy 819 aTel e & Req SATHTT (word size) TG g gl
Options :

1. ¥ 64 bits

2. % 74 bits

3. % 38 bits

4. % 16 bits

Question Number : 7 Question Id : 2549897618 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

A port transmits one bit at a time.
Options :

1. ¥ serial



2. # parallel
3. % line
4. ® FireWire

Question Number : 7 Question Id : 2549897618 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time :

Correct Marks : 1 Wrong Marks : 0

O, e 9l s W & © U H Ue §R H U 9T & Jaild dRar g |
Options :

1. ¢ HiREd

2. % GHMIR/IRAA

3. % g

4. % IIRAIR

Question Number : 8 Question Id : 2549897896 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Which of the following icons indicates that a file or folder is in the process of updating in the Dropbox folder on your computer?

Options :

-




O

Question Number : 8 Question Id : 2549897896 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
9 T q HH-I1 38 37 BT & b 3P FHER R SIS BisR | g WIsd T1 HIes? HTST 811 &1 Ufehar & g2

Options :

-
O
Q

O

4.

Question Number : 9 Question Id : 2549898715 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is considered to be the first supercomputer developed in India, by C-DAC?
Options :

1. ¥ MIHIR

2. ¥ PARAM 8000



3. ¥ PRATYUSH
4. % EKA

Question Number : 9 Question Id : 2549898715 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time :

Correct Marks : 1 Wrong Marks : 0

YRA H 1-S& (C-DAC) gRIT fasRid Ugal YR e 9 & ¥ fod 7T oirar g2
Options :

1. % fifgR (MIHIR)

2. % UXH 8000 (PARAM 8000)

3. % JY (PRATYUSH)

4. % THT (EKA)

Question Number : 10 Question Id : 25498911688 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is used to get the processed information i.e, output by submitting input to the computer?
Options :

1. # System bus

2. % Memory

3. % Storage

4. ¥ CPU

Question Number : 10 Question Id : 25498911688 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

frafafad # 9 foraeT ST TS STH&R! !, HEeR # 3YC JaHe Hdb TICYT U d3- & ol [T ST g2
Options :

1. % Rrersg

2. % O}

3. % SR (Storage)




4. ¢ Uy (CPU)

Question Number : 11 Question Id : 25498913747 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

An is an advanced port designed for video cards and 3D accelerators.
Options :

1. # AGV

2. % AGI

3. % AGC

4. ¥ AGP

Question Number : 11 Question Id : 25498913747 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :
1. ®* AGV
2. % AGI
3. % AGC
4. ¥ AGP

Question Number : 12 Question Id : 25498930209 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is the value of the following MS-Excel function, =FLOOR(14,4)?
Options :

1.9 12

2. %3

3.% 14

4. % 144



Question Number : 12 Question Id : 25498930209 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Excel BaRF =FLOOR(14,4) &1 HH &1 I
Options :

1.¥ 12

2.%3

3.% 14

4. % 144

Question Number : 13 Question Id : 25498930662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The ability to do error-free calculations represents the characteristic of the computer.
Options :

1. * Scalability

2. % Speed

3. ¥ Accuracy

4. % NolQ

Question Number : 13 Question Id : 25498930662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

HEER GRT (e fEd UM H3A B! fa=Ivar 1 FHeard 82

Options :

1. % QUG (Scalability)
2. % T1fd (Speed)

3.9 qmm (Accuracy)

4. % A giadisl (No 1Q)

Question Number : 14 Question Id : 25498933924 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Which of the following are two most commonly used types of touch sensors with reference to [oT products?

Options :

1. ¥ Capacitive and Resistive Sensors

2. % Smoke Sensors and LM35

3. % LM35 and Accelerometer

4. % Accelerometer and Smoke Sensors

Question Number : 14 Question Id : 25498933924 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

ToT 3Gl & T&H o, Fafifed & ¥ 319 3 & Jraiive Iudi fbT I aTd °d YR 52
Options :

1. ¢ HURIfeT iR Iifed TR

2. % W% W SR LM35

3. % M35 3R TRIARHCR
4. % THRICRIHER 3R T W

Question Number : 15 Question Id : 25498934082 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Each MIDI interface supports how many channels?
Options :

1. %2

2.¥ 16

3.% 8

4. % 4

Question Number : 15 Question Id : 25498934082 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :

1. %2

2. ¢ 16

3. % g

4. % 4

Question Number : 16 Question Id : 2549896918 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Personal computers can be connected together to form a
Options :

1. * server

2. * super computer

3. ¥ network

4. % enterprise

Question Number : 16 Question Id : 2549896918 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

G HHX HIUH R A NS B TH 1 ol Gl ¢ |
Options :

1. % Fa

2. % R HYR

3. ¥ Fcdd

4. % QUCIYIgY

Question Number : 17 Question Id : 2549897339 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Which of the following file format is used by windows installer during windows installation?



Options :
1. # .avi
2. % msi
3. % EC3
4

. % mp3

Question Number : 17 Question Id : 2549897339 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :

1. * .avi
2. ¥ msi
3. % EC3
4

. % mp3

Question Number : 18 Question Id : 2549897757 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

ISDN stands for Services Digital Network.
Options :

1. ¥ Integrated

2. % Inner

3. % Internal

4. % Inbuilt

Question Number : 18 Question Id : 2549897757 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

ISDN &7 31 & gfaoy fefored Aead |
Options :

1. ¢ 3ciifes




2. % IR
3. ® go-d
4. % Mg

Question Number : 19 Question Id : 2549898201 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Application firewall is also known as:
Options :

1. ¥ Application Gateway

2. % Application Switch

3. % Application Security

4. % Application Hub

Question Number : 19 Question Id : 2549898201 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
BT PRRA D W RIS g|
Options :

1. ¢ Ty TIed

2. % TRy

3. % QIR JRE&T

4. % YWD §d

Question Number : 20 Question Id : 2549898365 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What will be the output of the following excel formula?
=CEILING.MATH(155,10)

Options :
1. % 150



2. % 15
3. ¥ 160
4. %5

Question Number : 20 Question Id : 2549898365 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
fafRed Tata Wide &1 $3eye ol g
=CEILING.MATH(155,10)

Options :

1. # 150

2. % 15

3.¥ 160

4. %5

Question Number : 21 Question Id : 2549899421 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Printer is a:

Options :

1. ¢ device that takes information from computer and prints it on a paper.
2. % device that stores information.

3. % device that processes the information.

4. # device to scan and print the information on a monitor.

Question Number : 21 Question Id : 2549899421 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

ﬁﬁ@:

Options :

1. ¢ T SUGRY 8, ST HHER F THGRI Al 8 3R 3¢ Th BTl W fife dxar g
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3. % TG IUBRUI &, S a1 I GHIeId e 3|
4. % TYI IYPDII g, S AER W SHBRI P Wb 3R flie HRAT g |

Question Number : 22 Question Id : 2549899556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
printers essentially spray ink onto paper through a nozzle in microscopic droplets.
Options :
1. % Dot matrix
2. % Mechanical
3. # Laser
4. ¥ Inkjet

Question Number : 22 Question Id : 2549899556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

I IrRad ¥ U@ Ao & T ¥ eF el (dah) & T U E ST IR el [5edd ¢ |
Options :

1. % gl Bfge

2. % APpHd

3. % WOR

4. FHolC

Question Number : 23 Question Id : 25498910805 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
is a device found on a computer printer that accepts track of paper and feeds them through the machine one by one.
Options :
1. ¥ Sheet feeder
2. % Print preview

3. # Print spooler



4. ¥ Print taper

Question Number : 23 Question Id : 25498910805 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
TP HeR fifer IR Ui 9 a1 fSa1sd § Sl BTN &1 ¢ WIHR HRd g 3R I8 M & A1eIH I Ueh-Uh R WIS Hd gl
Options :
1. ¢ ic B
2. % flic iy
3. % flic WeR
4. % flc TR

Question Number : 24 Question Id : 25498911102 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Devices such as monitors, printers, and keyboard, that connected to the computers are collectively called as
Options :

1. % Wireless Devices

2. % Input Devices

3. ¥ Peripheral Devices

4. ¥ Network

Question Number : 24 Question Id : 25498911102 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

SR Y IS AieR, e SR SIEIS oY STV Bl Ao ©UY  Hel gl
Options :

1. % qrRey fEargy

2. % gYC f&argy

3. ¢ URBR f&arsy

4. % qcdd




Question Number : 25 Question Id : 25498913364 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
compression technique can NOT completely recover original data.
Options :
1. #® Dirty
2. ¥ Lossy
3. ® Lossless

4. % (Clean

Question Number : 25 Question Id : 25498913364 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

YIS o I RE W Tl Sel IHUI 81 R gl 6|
Options :

1. % 3¢ (Dirty)

2. ¥ W(Lossy)

3. % W(Lossless)

4. % &I (Clean)

Question Number : 26 Question Id : 25498913773 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
key algorithms uses one key for encryption and another for decryption.
Options :
1. * Secret
2. % Personal
3. ®* Shared
4. ¥ Public

Question Number : 26 Question Id : 25498913773 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

ol TENRYH TP & fort fdt uer &1 3R fEformm & for fordht gust oit &1 SuahT e 3|

Options :

1. % T (3idhe)
2. % Jufadsd (qa)
3. % YT (RU3MS)

4. ¥ A (UfsTeh)

Question Number : 27 Question Id : 25498913911 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In IP address 192.168.1.255, 255 is assigned as:
Options :

1. # device address

2. ® automatically assigned network address
3. % gateway address

4. ¥ broadcast address

Question Number : 27 Question Id : 25498913911 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

IP U39 192.168.1.255 H 255 B! fhd YR ST fobar T g2
Options :

1. % fearsqugy

2. % IadIfed U Y 3RS fohdT T Aead Tgd
3. % Tled Ugy

4. ¥ SIS TgY

Question Number : 28 Question Id : 25498918588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

When using WINDOWS, what are the general steps to Install an OS using VM Ware?

Options :

1. # (1) Create New virtual machine using Windows OS (2) Select OS and its version (3) Locate ISO file of that OS (4) Install OS (follows
screens) (5) OK

2. % (1) Create New virtual machine using Linux OS (2) Select OS and its version (3) Locate ISO file of that OS (4) Install OS (follows screens)
(5) OK

3. ¥ (1) Install VMWare (2) Click New virtual machine (3) Select OS and its version (4) Locate ISO file of that OS (5) Install OS (follows
screens) (6) OK

4. # (1) Install VMWare (2) Click New virtual machine (3) Select OS and its version (4) Install OS (follows screens) (5) OK

Question Number : 28 Question Id : 25498918588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

WINDOWS &1 IUTNT B THY, VM Ware BT STINT b OS R B P JraT IR0T T 82

Options :

1. # (1) Windows OS &T UdITT & Create New virtual machine TR & &3 (2) 0S 3R 3B TWHRUI BT I B (3) 39 08 FI [SO HISH
@G (4) OS T B (ThIF BT IRV HI) (5) OK

2. % (1) Linux OS T YGNT &R Create New virtual machine TR f&® &3 (2) 0S 3R S TR0 &1 T B (3) 39 0S B 1SO BId ga
(4) OS RO B (T BT IR HY) (5) OK

3. ¢ (1) VMWare RITUT X (2) New virtual machine TR f&® &% (3) 0S 3R 3B TIHU] BT TIT B (4) 39 0S DI 1SO WQ\% (5) 0S
RO B (1 BT IR HY) (6) OK

4. % (1) VMWare RITUT &Y (2) New virtual machine TR f&Td 3 (3) 0S 3R 5T TXHUI BT TG B (4) OS RITIT B (FpIH BT

SR BY) (5) OK

Question Number : 29 Question Id : 25498924295 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Operating system resides:

Options :

1. ¥ HDD

2. ¥ ROM

3. # PROM



4. % EEPROM

Question Number : 29 Question Id : 25498924295 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
SfToRfeT Rew wAlgl
Options :

1. ¥ HDD

2. ¥ ROM

3. ¥ PROM

4. ¥ EEPROM

Question Number : 30 Question Id : 25498924981 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a type of redundancy used in image compression?
Options :

1. # Psycho-visual Redundancy

2. % Inter-pixel Redundancy

3. ¥ Time Redundancy

4. % Coding redundancy

Question Number : 30 Question Id : 25498924981 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

frofaRad o 9 w1 ofa Jotea & SuaiT &1 ST aTelt 3okl &1 Ue UHR T8l o7
Options :

1. % GrEPhIl-fagsera sifoRendT

2. % SR fUae Sifaepd

3. ¢ Gy 3ffcRepd]

4. % DIST 3ffcRepdl




Question Number : 31 Question Id : 2549896531 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
are used to identify a user who returns to a website.
Options :
1. ¥ Cookies
2. % Plug-ins
3. % Scripts
4. % ASPs

Question Number : 31 Question Id : 2549896531 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
BT ST fHI} ITAZE R dic I SUTNTH A i UgdH B b fold fohar S g |

Options :

1. ¢ W(Cookies)

2. % -9 (Plug-ins)
3. % W(Scripts)

4. = ASPs

Question Number : 32 Question Id : 2549897105 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In Gmail, deals and offers are part of the tab.
Options :

1. # updates

2. % promotions

3. % forums

4. % primary

Question Number : 32 Question Id : 2549897105 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Gmail ¥ TI¢ 3R TaTd 9 &1 fie= g
Options :

1. % 3UscyH

2. ¢ JAIRN

3. % HRAE

4. % JISER]

Question Number : 33 Question Id : 2549897498 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is the shortcut key used to insert hyperlink in MS-PowerPoint 20167
Options :

1. % Alt+F1

2. % Alt+F2

3. ¥ Cul+K

4. % Cul+B

Question Number : 33 Question Id : 2549897498 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-PowerPoint 2016 H IR UfAY HRaM & ol SUART &1 O dTel! Qe dhe ol 31 g2
Options :

1. * Alt+F1

2. % Alt+F2

3. ¥ Cul+K

4. % Cul+B

Question Number : 34 Question Id : 2549897953 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



Which of the following is a free app developed by Nolan Amy that can be used on IOS or Android operating system for pre-assessments, checks
for understanding, polls or class surveys, tickets out the door, TCAP review, etc?

Options :

1. ¥ Plickers
2. % Flickers
3. # Scanners
4. % Pluckers

Question Number : 34 Question Id : 2549897953 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
frafeafead & @ o 1 Aia T gR1 fawRia e T e U0 § et SUahT [0S 31a Ug15s SiTiRfeT Red R yd-Jeaid, Tq
&1 Sl T a1 aFf GA&0T, S1eR 9 fede T, TCAP Teiten 3fe & forg fosan o wahan &2

Options :

1. ¢ fRIHY (Plickers)
2. % @Y (Flickers)
3. % W(Scanners)
4, # W(Pluckers)

Question Number : 35 Question Id : 2549898009 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is the maximum per transaction limit for sending money in BHIM payment interface as of January 20227
Options :

1. % 20,000

2. % 100,000

3. % 50,000

4. % 25,000

Question Number : 35 Question Id : 2549898009 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

SHaRT 2022 T% B RUMA & IR, HiF (BHIM) UHT Sexthd § U U & fog Ufd TSaRM (transaction) @1 3ifererdd IAT o1 82
Options :

1. % 20,000

2. % 100,000

3. % 50,000

4. % 25,000

Question Number : 36 Question Id : 2549898105 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Which of the following types of pie chart contains more than one data series at a time in MS-Excel 2016?

Options :

1. ¥ Doughnut
2. # Clustered
3. % Stacked
4. % Bar

Question Number : 36 Question Id : 2549898105 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Excel 2016 H, FHfIRad # ¥ fd YR & U8 91¢ H T 900§ T I 31fed ScT §ae gidl 82
Options :

1. ¥ B¢ (Doughnut)

2. % FAYCS (Clustered)

3. % WFS (Stacked)

4, % dIR (Bar)

Question Number : 37 Question Id : 2549898120 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



Which of the following statements is INCORRECT with respect to surface chart in MS-PowerPoint 2007?
Options :

1. # Useful when you want to find optimum combinations between two sets of data.

2. % Uses chart when both categories and data series are numeric values.

3. ¥ This type of chart requires four series of values in the correct order (open, high, low, and then close).

4. % 3.D surface charts show trends in values across two dimensions in a continuous curve.

Question Number : 37 Question Id : 2549898120 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-PowerPoint 2007 H, T TT¢ & A H HIH-91 HY- 7Tdd g2
Options :

1. % a9 START 51d 319 ST & &) el & a9 3PaH Ao WioHT1 I8 g |

2. % IC &1 TANT [T ST § 519 i1, aF Ud Sl &1 YRSl &1 Ao WATHS Il 8 |

3. ¢ TYUSBR & d1C H Tal A H Yol & IR Raaait (g, 3=, g, 3R R &) o srawadar usdl g
4. % 3.D qHY A1¢, Uh qad as | &f 3 & ool & ¢ g faard |

Question Number : 38 Question Id : 2549899156 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

To conduct voice chat with your family and friends, you need to use
Options :

1. ® antivirus

2. ¥ Google Meet

3. ® plickers

4. % MS Word

Question Number : 38 Question Id : 2549899156 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
30 aRaR IR il & WY 9l o dA & fog 3! BT YA BT BRI

Options :



1. % TRy
2. ¥ I e (google meet)
3. % W(plickers)

4. % MS Word

Question Number : 39 Question Id : 2549899197 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
is a type of personal website where articles are regularly posted.
Options :
1. # Google
2. ¥ Web log
3. % Word processor

4. ¥ Microsoft outlook express

Question Number : 39 Question Id : 2549899197 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

TS UPHR DI AGAd 99 WIZC ¢ 98! HAid U I o URe fhu od g |
Options :

1. * IJIT<T (Google)

2. ¥ aaa'\ll"T(Web log)

3. % I8 URRR (Word processor)

4. % TISHINITE 3D TR (Microsoft outlook express)

Question Number : 40 Question Id : 25498910487 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following options is used to capitalize the first letter of a sentence and leave all other letters as lowercase in MS-Word 2016
document?

Options :



1. # Paragraph Case
2. # Section Case
3. % Sentence Case
4. # Toggle Case

Question Number : 40 Question Id : 25498910487 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word 2016 Siagie H, fFafafad & § {6y fawed o1 wanT ared & Ugd 318R &1 §3 31&R (capital) H forga 3R 37 Taft s1eri oI
NRPY & =0 & Blg & forg fovar ST g2

Options :

1. % TR &Y (Paragraph Case)

2. % JIRE Y (Section Case)

3. ¢ AT hY (Sentence Case)

4. % T B (Toggle Case)

Question Number : 41 Question Id : 25498910654 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In computer graphics, we can adjust the shape of the line ends to give them a better appearance by using:
Options :

1. # line spacing

2. # more dots

3. % square caps

4. ¥ line caps

Question Number : 41 Question Id : 25498910654 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

HR Mhaq H, 50 A7 T I frae! Tgrdl 9 A8 & SHIHR 6! ARG HRb 30 Sk SURT o & o THTIoId &R Jahd 52

Options :




1. % g Wi
2. % 3{f¥ fdg
3. % PHR HH
4, ¢ AR b

Question Number : 42 Question Id : 25498910662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following pagination controls in the Line and Page Breaks tab places at least two lines of a paragraph at the top or bottom of a page
in MS-Word 2019?

Options :

1. ¥ Widow/Orphan control
2. # Page break before

3. # Keep with next

4. % Keep lines together

Question Number : 42 Question Id : 25498910662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word 2019 ﬁ, NIEK! 3R U9 sy o9 & FRgforiRad & 9 oF-a1 afomze Ao (pagination controls) Udh OW & SR T 1 BT B
HH Y H G AT DI 3@l 82
Options :

1. ¢ Tq8Y/3iith a'ﬁj?[ (Widow/Orphan control)
2. % U9 9 [dBR (Page break before)

3. % Y fag Aae (Keep with next)

4. % PIY AR gﬁa (Keep lines together)

Question Number : 43 Question Id : 25498910686 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
A/an section break lets you start a new section on the next odd-numbered page in MS-Word 2016.
Options :



1. # next page
2. % continuous
3. % even page
4. ¥ odd page

Question Number : 43 Question Id : 25498910686 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS Word 2016 ®, IR S T 3Tel fao T aral U IR Ueh 197 HaRH R - Gl |
Options :

1. ® R U

2. % B3

3. % 39U

4. g Ual

Question Number : 44 Question Id : 25498911444 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following options in MS-Word 2010 is NOT present in the proofing ribbon?
Options :

1. % Spelling & Grammar

2. % Research

3. ¥ New comment

4. % Word count

Question Number : 44 Question Id : 25498911444 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS Word 2010 &, 3R[fg 9 (Ffth™) Ug! & - & ¥ &1 1 fdeved HiNg 181 62

Options :

1. % o) 3R SITHT (W TS UTR)




2. % 3T ()
3. ¢ T3 fewuft (g wHe)
4. % TMeg TUMT (TS HIIC)

Question Number : 45 Question Id : 25498911861 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Word 2007 revisions, changes, and corrections are typically shown in the near or in the margin of the page.
Options :

1. # ruler

2. # header

3. % footer

4. ¥ balloons

Question Number : 45 Question Id : 25498911861 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word 2007 H Gteror, URad 3R GUR MR TR g§ & U a1 ATfoi & A i@ o B
Options :

1. # R

2. % g

3. ¥ HR

4. I

Question Number : 46 Question Id : 25498911934 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Raghu wants to create a table in MS-Word 2013 with five columns; which of the following option must he choose?
Options :

1. * Quick tables

2. % AutoFit contents



3. # AutoFit to window

4. ¥ Insert Table -> Number of columns

Question Number : 46 Question Id : 25498911934 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Y MS-Word 2013 H UFa Hier aTclt diferesT ST agdl &, S fufifad # @ &1 91 fawed g anfew
Options :

1. % b o

2. % JIClfthe by

3. % 3lcifthe ¢ fdel

4. TC I -> R 3 PHlerw

Question Number : 47 Question Id : 25498918967 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following shortcuts can be used to see the Print Preview of the MS-Word 2019 document?
Options :

1. # CTRL+F1

2. % CTRL+F4

3. % CTRL+F3

4. ¥ CTRL+F2

Question Number : 47 Question Id : 25498918967 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word 2019 SiagHc &1 fiic iy &= & e g o 9 for Riicdhe &1 ITANT i ST Havdl 62
Options :

1. ¥ CTRL+F1

2. % CTRL+F4

3. # CTRL+F3



4. ¥ CTRL+F2

Question Number : 48 Question Id : 25498919244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Reena wants to change the font style of the return address of an envelope during mail merge process in MS-Word 2019. Which of the following
options are used?

Options :

1. ¥ Mailings

2. % References
3. % Page layout
4. # Design

Question Number : 48 Question Id : 25498919244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

ST MS-Word 2019 H, A TSl (mail merge) UfohdT & SR U fTHBTH (envelope) & Red T3H &t Wi el &I ST argdl ¢ | Fafafaa
7 3 fry fasey o1 IuaNT fhar Sirar g2

Options :

1. ¢ At (Mailings)

2. % VB (References)

3. % U9 qefI3e (Page layout)

4. % {SoIeH (Design)

Question Number : 49 Question Id : 25498924863 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is the correct order of action to create a pivot table in MS-Excel 2016?
Options :

1. # Menu > PivotTable > Insert > Create PivotTable > Range

2. % Menu > PivotTable > Insert > Range > Create PivotTable

3. % Menu > Insert > PivotTable > Create PivotTable > Select table or Range



4. # Menu > PivotTable > Create PivotTable > Insert > Range

Question Number : 49 Question Id : 25498924863 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS Excel 2016 T, fUdie ¢aa 991 & fore fFa & @ & 91 fovan &1 98! v 82
Options :

1. ¥ Menu > PivotTable > Insert > Create PivotTable > Range

2. # Menu > PivotTable > Insert > Range > Create PivotTable

3. % Menu > Insert > PivotTable > Create PivotTable > Select table or Range

4. # Menu > PivotTable > Create PivotTable > Insert > Range

Question Number : 50 Question Id : 25498925316 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What are the steps to open new readymade templates in MS-Word 20107

Options :

1. # File (office Button) — open — select all word template from dialouge box

2. % Cannot open readymade templates

3. ¥ File (office Button) — New — Sample Template — Select any template from available templates
4. ® File — Open — select Templates

Question Number : 50 Question Id : 25498925316 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word 2010 H, 797 ga-Hd ¢reie @ia- o forg f-m o 9 fost aRul &7 SaRur 631 g
Options :

1. ® TT2d (ThY ge) - 3 - SFa sy ¥ I+t a8 ermae g+

2. % Ud Piffq e ) e o Wd B

3. ¢ 1R (AT ) — g - Jud Tale - I SHaied § § ois Wt eweie 3=

4. % I3d — U — I A



Question Number : 51 Question Id : 25498925336 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following ribbon navigation short cut key is used to go to Layout tab in MS-Word 2019?
Options :

1. ¥ Alt+P

2. % Atl+N

3. % Alt+H

4. % Alt+G

Question Number : 51 Question Id : 25498925336 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word 2019 H, T3{T3< 8 R oH & fore fg & T forg Ree Afaawm wiiésme o1 (key) 1 STRT o 511 82
Options :

1.¥ Alt+P

2. % Atl+N

3. % Alt+H

4. % Alt+G

Question Number : 52 Question Id : 25498934484 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is capable of playing audio and video streams?
Options :

1. #* Audio player

2. % MP3 player

3. ¥ Media player

4. % Audio CD player

Question Number : 52 Question Id : 25498934484 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

ﬁ'ﬁﬁﬁaﬁ:{-ﬂl 3irsar @Tm@qﬁﬂﬂﬁ (playing) o gem 72
Options :

1. %3S W

2. % MP3 @R

3. ¢ HIfSTT iR

4. % 3TSA CD WIR

READING COMPREHENSION

Section Id : 2549895520
Section Number : 2

Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 1

Number of Questions to be attempted : 1

Section Marks : 5

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549895561
Question Shuffling Allowed : Yes

Question Id : 25498920875 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Question Numbers : (53 to 57)
Read the given passage and answer the questions.

Hanumanthappa

One bright June morning I was reading the newspaper. That day the Secondary School Leaving Certificate results had been published. The list of



the rank holders and their photographs took up almost the entire front page. Of all the photographs, one boy's snapshot caught my attention. He
looked sickly and pale, but there was a sparkle in his eyes. I read that his name was Hanumanthappa and that he had secured the eighth rank.

The next day, his photograph was published again with an interview. I learnt that Hanumanthappa was a coolie's son, the oldest of five children.

They belonged to a tribal group. He was unable to study further, because he lived in a village and his father, the sole breadwinner, earned only
Rs. 40 a day.

Hanumanthappa's postal address was provided in the interview. I immediately wrote to him saying that [ was interested in meeting him and asked
whether he could come to Bangalore. I added that I would pay for his travel and some clothes. Within four days I received a reply, thanking me
for the letter and expressing his willingness to come and meet me. Immediately, I sent him some money and details of my office address.

When he finally arrived in our office, I got straight to the point. 'Do you want to study further? We would like to support you. We will pay your
fees for any course of study you wish to take up.' He did not answer. My senior colleague interrupted with a smile. 'Let the boy understand what
you are suggesting. He can give his answer at the end of the day.'

When Hanumanthappa was ready to return home, he said in a low and steady tone, '"Madam, | want to continue my studies at the Teacher's
Training College in Bellary. That is the one nearest to my village.' I agreed instantly but spoke to him a little more to find out whether there was
any other course he would like to choose. The boy, however, seemed to know exactly what he wanted.

I prayed that God would continue to bestow the best on Hanumanthappa and his family.
Sub questions

Question Number : 53 Question Id : 25498920876 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What was special about the day described in the first paragraph?

Options :

1. # The author had a meeting with one of the rank holders.

2. % The newspaper was delivered much before the usual time.

3. ¥ The Secondary School Leaving Certificate results had been declared with photographs of the rank holders.
4. % There was a full page advertisement about Teacher Training Colleges of Karnataka.

Question Number : 54 Question Id : 25498920877 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
What inspired the author to help Hanumanthappa for further studies?
Options :



1. ¥ Hanumanthappa's bright and sparkling eyes in his weak and pale face attracted her.

2. ¥ Hanumanthappa had stated in an interview that he did not want to study further because his father was very poor.
3. ¥ Hanumanthappa had written to the author for help.

4. ¥ The author wanted to help the poor but intelligent rank holder

Question Number : 55 Question Id : 25498920878 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Hanumanthappa wanted to join the Teacher's Training College at Bellary because
Options :

1. # he did not have any ambition for his future.

2. # he wanted to join a course that would take a long time to complete.

3. % wanted to burden the author by joining an expensive course.

4. ¥ he did not want to travel very far from his village.

Question Number : 56 Question Id : 25498920879 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Choose the alternative that is NOT correct.
What do we learn about the author from this passage?

Options :

1. # She wanted to know what was happening in the country.
2. % She admired other people’s intelligence and hard work.
3. # She was kind and helped needy people.

4. ¥ She forced other people to accept her decisions.

Question Number : 57 Question Id : 25498920880 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Based on the passage, which one of the following statements is true of Hanumanthappa's character?
Options :

1. # He was honest and sincere in all his work.

2. # He was prompt and precise in his correspodence.



3. % He was capable of taking firm decisions.

4. * He was always eager to meet new people.

Question Id : 25498920875 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Question Numbers : (53 to 57)

faQ T T B U 3R ITF MYR W U & IR S|

e JHITYWI

S &1 Ue gHGER Y8 H YR U UG 8! | 39 o Areafiies woa aifd™ Aficfhdie o1 alien &1 uiRomd yestiRid fasar mar 1| ¥&
URD| B YT AR D! AGRI = THT IR T aTel I8 DI 4R fam o711 Juft AR & I T a8 o Wie) A -1 &1 Wil | 98 SR 3R
HUIR T IT YT, Afh1 31 3fiE! H T 7He ot | T Ul o ITHT 10 FTHHYTT AT 3R 3T 313t b givid b ot

AT &1, IHDT TR T R b 1Y bR J U1 g3 2| Y Ul 1 o STHHYTT Uh it T e 8, S Uie HIS-Sg-1 o Tad §aT
%ligﬁglg‘m T 9 ¥ 98 AW 3T - H SRH T, Fifch 98 Ueb Tid | X8l 4T 3R I T, THHE HHM ar, i o daa
40 |

SIHHYW &1 316 HI U ST A oo mar o1 H3 R IY I8 Hed gu foran i 02 IO firen o1 587 § SiR YT % 1 a8 S7ak o
qHd1 g | B4 gl [ & IUD! T 3R HUS! & ore U9 §ift | IR farl & iR, 731 & fore g9 e=ga1g iR o1 SR gerd e &t 3=
ad HRd U H IR el T4, B IV &9 FU 3R IR HEafeg & ud & faaror 99

O 98 3idd: SHR Hraferd ugar, a & T & ot §1d UR 311 T | 1 gH S UgHT I1ed 817 §H JReR] gTIdl &A1 I18d & | g1 Ugls
o1 ol ot fawa AR, I9h ol 89 I &1 YA Bl ' ST SIdTd o1 16aT| TR aRg Tgant = GIHRT & g4 AP 'ASH Bl GHI- ¢ fb
31T &1 YATG ¢ 381 ¢ | 98 WMH AP 30T SId1d ¢ el G|

O SIHHYWI R e & fo daR o1, 35 ¢l SR fRR WR & Fal, By, # gear) § Fer S wrast §f 30t Ugrs Sk} G- ared]
g1 98 IR ITd & o ole 1o ¢ I' T gid TgHd 81 T8 Alfdh I8 S & foll ST AUIST 3R a1d 1 o o1 98 Big 30 B g1 argdl |
gTdifch, TSI ST UT fd dg oaT JrgdT Tl

T3 urefr Y fb WA ST 3R 3% URAR &1 YAIF UaH oAl SR} TG |

Sub questions

Question Number : 53 Question Id : 25498920876 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

Ugd RPN # aftfd fom & ar o & faiy 4

Options :

1. % ORGP &1 TH ¥b YRS & 1Y 93P g3 |

2. % JUMER UF G fe1 &1 a1 § D1 Seg] fear 4T
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4. ® PHCH & SR T Piciol & g H Th X Ul & TaTa |

Question Number : 54 Question Id : 25498920877 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :
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Question Number : 55 Question Id : 25498920878 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Question Number : 56 Question Id : 25498920879 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Question Number : 57 Question Id : 25498920880 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :
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QUANTITATIVE APTITUDE
Section Id : 2549895521
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549895562

Question Shuffling Allowed : Yes



Question Number : 58 Question Id : 25498914226 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
What approximate value should come in place of the question mark (?) in the following question? (rounded off to nearest tens)

1548.45 + 3065.15 + 15.058 = ?
Options :
1. * 1700
2. % 1650
3. % 1840
4.+ 1750

Question Number : 58 Question Id : 25498914226 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
frafafad uy & uy iR (2) & R W AT HH &1 1 91feW? (Rdedd aRmMad R d& Juf )

1548.45 +3065.15 + 15.058 = ?
Options :
1. ®* 1700
2. % 1650
3. % 1840
4.+ 1750

Question Number : 59 Question Id : 25498914230 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Two-thirds of three-fourths of one-fifth of a number is 15. What is 30 per cent of that number?
Options :

1« 45



Question Number : 59 Question Id : 25498914230 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

& Ter & uEe few F d=-gtug @ g Qe 15 81 39 wew # 30 wfaera fFaar gem?

Options :
|« 45

, = 60
3 % /5

4. % 30

Question Number : 60 Question Id : 25498914231 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

A 180-metre long train crosses another 270-metre long train running in the opposite direction in 10.8 seconds. If the
speed of the first train is 60 kmph. what is the speed of the second train in kmph?

Options :
| % 80

2.« 90



3 % 150

4 % Cannot be determined

Question Number : 60 Question Id : 25498914231 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
180 #Hrex &€ v &7 RAoda er & o @ v 3y 270 Hex & &7 Fr 10.8 FFET H 9N FaT 2
ofe Tgelr ¢ #r aifad 60 kmph g, aF kmph & g@dr &1 #r aifa fRaar gef?

Options :
1 = 80

2. v 90

s % 150

, « [T A H AT FHAT B

Question Number : 61 Question Id : 25498914366 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
From a well-shuffled pack of 52 playing cards. one card is drawn at random. What is the probability that the card drawn
will be black king?
Options :
1
1V 26



Question Number : 61 Question Id : 25498914366 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
TS 3] e el 83 52 Ui 1 T3] ¥ Ueh Ul o RS (ehTel o1l 8 | Ui o7 BTl STERITE B 1 ol JHIET 82

Options :
1
1.« 26

Question Number : 62 Question Id : 25498928777 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



What would be the compound interest accrued on an amount ofF 7 400@ 13.5 p.c.p.a. at the end of two years? (rounded
off to two digits after decimal)

Options :
| % T 2.136.87

, x T2306.81

4 v ¥2,132.87

Question Number : 62 Question Id : 25498928777 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

37,400 #r TfYr 9 13.5% s a7 X THAd Tohgia A1 &f IY a1E fohdal gRM? (e & a5
ar 3R a)

Options :

L% <2.136.87

, » X2,306.81

3 % 2,032.18

4 o X2,132.87



Question Number : 63 Question Id : 25498928782 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Study the given information carefully to answer the questions that follow:
A basket contains 4 red. 5 blue and 3 green marbles.
If three marbles are picked at random, what is the probability that either all are green or all are red?
Options :
7
1% 44

Question Number : 63 Question Id : 25498928782 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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GENERAL MENTAL ABILITY AND REASONING

Section Id :

Section Number :
Section type :
Mandatory or Optional :
Number of Questions :

Number of Questions to be attempted :

Section Marks :
Display Number Panel :

Enable Mark as Answered Mark for Review and Clear Response :

Maximum Instruction Time :
Sub-Section Number :
Sub-Section Id :

Question Shuffling Allowed :

Question Number : 64 Question Id : 25498910133 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

2549895522
4

Online
Mandatory
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6

6

Yes

Yes

0

1
2549895563
Yes



Correct Marks : 1 Wrong Marks : 0
Select the option that is related to the third term in the same way as the second term is related to the first term.

Dum Dum : Kolkata :: Palam : ?
Options :

1. # Kerala

2. ¥ Delhi

3. #* Chennai

4. % Mumbai

Question Number : 64 Question Id : 25498910133 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

39 faed o1 g S R Teg F Siep I R T Taifdid & o e gHjT Weg Usd g & Taifera B

SHSH : HIAGI :: UTaH : ?
Options :

1. % P

2. ¢ ol

3. % 98

4. % Hag

Question Number : 65 Question Id : 25498912865 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Find out how many such pairs of letters are there in the given word each of which has as many letters between them in the word as in the English
alphabet.

DECORATE
Options :
1. * Nil
2. % One

3. # Two



4. % Three

Question Number : 65 Question Id : 25498912865 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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DECORATE
Options :

1. % JY

2. % U
3.8 Q)
4.« dH

Question Number : 66 Question Id : 25498912898 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Find out which of the letter-series follows the given rule:

Number of letters skipped in between adjacent letters in the series doubles every time.
Options :

1. ® ADIPY

2. ¥ BDGLU

3. % EGJOF

4. % GINSY

Question Number : 66 Question Id : 25498912898 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :




1. # ADIPY
2. ¥ BDGLU
3. ¥ EGJOF
4. % GINSY

Question Number : 67 Question Id : 25498919603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Select the alternative with the most appropriate description about these three words.

Chain : Link : Bridge

Options :

1. # They all have books.

2. % They are related with ornaments.
3. ¥ They join two parts.

4. % The terms are related with prison.

Question Number : 67 Question Id : 25498919603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :

1. % 39 g 9t forare B

2. % YT 9§ GIRA &

3. ¢ AT YT & Sisd ¢ |

4. % U Teg ol I WS B

Question Number : 68 Question Id : 25498919730 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



A bowl of sweets was placed on a table to be distributed among three brothers- Rajan, Sajal and Karan. Rajan arrived first and ate what he
thought was his share of sweets and left. Then, Sajal arrived. He thought that he was the first one to arrive and ate the number of sweets and he
had his share and left. Lastly, Karan arrived. He again thought he was the first one to arrive and he took what he thought was his share. If 16
sweets are left in the bowl finally, how many sweets did the bowl contain initially?

Options :
1. #® 27
2. % 36
3. % 48
4. ¥ 54

Question Number : 68 Question Id : 25498919730 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

T UTEEN. T, ToTd 3R BT & S fIaRd B & ot Uep AW UR fSTS T Ueh R QT 7T AT | IS Uga Ugdn 3R 39+ fHaTs &1
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Options :

1. % 27

2. % 36

3. % 48

4. ¢ 54

Question Number : 69 Question Id : 25498919880 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Four words have been given, out of which three are alike in some manner, while the fourth one is different. Choose out the odd one.
Options :

1. ¥ Seal

2. * Scorpion

3. * Fish

4. % Lion



Question Number : 69 Question Id : 25498919880 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is

Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :
1. ¢ e
2. % fog
3. % gt
4. % 138

Section Id :

Section Number :

Section type :

Mandatory or Optional :

Number of Questions :

Number of Questions to be attempted :
Section Marks :

Display Number Panel :

Enable Mark as Answered Mark for Review and Clear Response :

Maximum Instruction Time :
Sub-Section Number :
Sub-Section Id :

Question Shuffling Allowed :

Question Number : 70 Question Id : 2549895242 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is

GENERAL AWARENESS

2549895523
5

Online
Mandatory
6

6

6

Yes

Yes

0

1
2549895564
Yes

Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In which of the following years was General Agreement on Tariffs and Trade (GATT) absorbed into the World Trade Organisation (WTO)?

Options :



1. * 1991
2.9 1995
3. % 2000
4. % 2005

Question Number : 70 Question Id : 2549895242 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

frafeied & 9 ®H-9 98 § Yewh 3R AUR TR THRT THAT (GATT) & % STIR W1e- (WTO) H e fasar mar ur
Options :

1. % 1991

2. % 1995

3. % 2000

4. % 2005

Question Number : 71 Question Id : 2549895513 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Significance of mitosis cell division is:
Options :

1. # increasing cellular mass.

2. % swift division.

3. % to occur in every tissue of body.

4. ¥ to produce cell genetically similar to parent cell.

Question Number : 71 Question Id : 2549895513 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

eI SRS fAUSH &1 1 Ted &2
Options :
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2. % fayroH digar Y gIar 3
3. % YRR & TAD SHdd H I4A g1 &b farg|
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Question Number : 72 Question Id : 2549899644 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Who wrote a book describing the theory of economic drain of India during British rule?
Options :

1. % Lala Lajpat Rai

2. % Mahatma Gandhi

3. # Jawahar Lal Nehru

4. ¥ Dadabhai Naoroji

Question Number : 72 Question Id : 2549899644 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

fefesr IR & SR YRd @) 3nffer i & Rigid o1 9uf &3 arelt fovare forem forgt 2t
Options :

1. % ST dToad I

2. % HgrE et

3. % SagR d1d "%

4. ¥ TIGTHTS ARSI

Question Number : 73 Question Id : 2549899805 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
Who wrote the book ‘Life Divine’?
Options :

1. ¥ Mulk Raj Anand

2. % Abul Kalam Azad



3. ¥ Aurobindo Ghosh
4. % Jawahar Lal Nehru

Question Number : 73 Question Id : 2549899805 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

TS fSarg Gdes fohe fora ot

Options :

1. % Hooh S TG

2. % A D dMH Al
3. ¢ RIS Uy

4. % SGIEY A A8

Question Number : 74 Question Id : 2549899810 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

To which part of India did the poet Igbal, who wrote ‘Sare Jahan Se Achchha Hindustan Hamara’, belong?
Options :

1. # Delhi

2. % Uttar Pradesh

3. ¥ Punjab

4. ¥ Hyderabad

Question Number : 74 Question Id : 2549899810 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

DId FhaTa foRI IR W8T F 37T fg el §ART foram U1, 98 HRd & fobg {4 Feiferd A9
Options :

1. % ool

2. % JW UK

3. ¢ OUd



4. % TG

Question Number : 75 Question Id : 25498912825 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The first Indian doubles who won a Bronze medal at the World Badminton Championship 2011 at London consisted of:
Options :

1. ¥ Jwala Gutta and Ashwini Ponnappa

2. % Saina Nehwal and Jwala Gutta

3. % Saina Nehwal and Ashwini Ponnappa

4. # Jwala Gutta and Harpreet Jadeja

Question Number : 75 Question Id : 25498912825 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0
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Options :
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Group Id : 2549893416
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Show Attended Group? : No
Edit Attended Group? : No

Break time : 1



Mandatory Break time : Yes

Group Marks : 0

Is this Group for Examiner? : No

Show Progress Bar? : No
English Mock

Section Id : 2549895524

Section Number : 1

Section type : Typing Test

Mandatory or Optional : Mandatory

Number of Questions : 1

Number of Questions to be attempted : 1

Section Marks : 0

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and Clear Response : Yes

Maximum Instruction Time : 0

Sub-Section Number : 1

Sub-Section Id : 2549895565

Question Shuffling Allowed : No

Question Number : 76 Question Id : 25498940809 Question Type : TYPING TEST Display Question Number : Yes Calculator : None

Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children have
fun during this process as they get to explore new arenas.
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Climate change includes both global warming and the resulting large scale shifts in weather patterns. There have been previous periods
of climatic change but since the mid twentieth century humans have had an unprecedented impact on Earth climate system and caused
change on a global scale. The largest driver of warming is the emission of gases that create a greenhouse effect of which more than ninety
percentage are carbon dioxide and methane. Fossil fuel burning for energy consumption is the main source of these emissions with
additional contributions from agricultural deforestation and manufacturing. The human cause of climate change is not disputed by any
scientific body of national or international standing. Temperature rise is accelerating. It is tempered by climate feedbacks such as loss of
sunlight reflecting snow or ice cover and increased water vapours. Changes in land and ocean carbon sinks are also a climate feedback.
Temperature rise on land is about twice the global average increase leading to desert expansion and more common heat waves plus
wildfires. Temperature rise is also amplified in the Arctic where it has contributed to melting permafrost glacial retreat and sea ice loss.
Warmer temperatures are increasing rates of evaporation causing more intense storms and weather extremes. Impacts on ecosystems
include the relocation or extinction of many species as their environment changes most immediately in coral reefs mountains and the
Arctic. Climate change threatens people with various problems such as food insecurity or water scarcity and flooding along with
infectious diseases and extreme heat waves. These human impacts have led the World Health Organization to call climate change the
greatest threat to global health in the twenty first century. Even if efforts to minimise future warming are successful some effects will
continue for centuries including rising sea levels and ocean temperatures. The Intergovernmental Panel on Climate Change has issued a
series of reports that project significant increases in these impacts as warming continues at a rapid rate. Further additional warming also
increases the risk of triggering critical thresholds called tipping points. Responding to these impacts involves both mitigation and
adaptation. Mitigation or limiting climate change consists of reducing greenhouse gas emissions and removing them from the
atmosphere. Methods to achieve this include the development and deployment of low carbon energy sources such as wind and solar
energy and a phase out of coal enhanced energy. Forest preservation is another important aspect of mitigation. Adaptation consists of
adjusting to actual or expected climate such as through improved coastline protection and better disaster management along with
assisted colonisation and the development of more resistant crops. Adaptation alone cannot avert the risk of severe widespread and
irreversible impacts. The environmental effects of climate change are broad and far reaching. Changes may occur gradually or rapidly.
Evidence for these effects comes from studying climate change in the past and from modern observation. Since the droughts and heat
waves have appeared simultaneously with increasing frequency. Extremely wet or dry events within the monsoon period have increased
in India and East Asia. The rainfall rate and intensity of hurricanes and typhoons is likely increasing. Frequency of tropical cyclones has
not increased as a result of climate change. Global sea level is rising as a consequence of glacial melt and melt of the ice sheets in
Greenland and Antarctica.
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